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Best Buy to return on November 12 
 

If you missed Tech Night in October it’s not too late to get into the know.  Another Best Buy crew will 
return for its third Tech Night on November 12 at 7:00 p.m. with tablets, cameras, and video games 
to wow us with the newest versions on the market.  Come and get ideas for everyone on your gift-
giving list: your children, grandchildren and yourself!  Best Buy’s Christine Wheaton will have coupons 
for the attendees.  
 
 

October Tech night draws another big crowd 
 

A Best Buy team returned in October for the second month in a row.  This time to present a series of 
computer and electronic items one might consider as Christmas gifts.   

 
 

(continued on next page) 
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Apple representative 

Chris Coni 

 
Best Buy’s door prize was a camera which was won by Alice Canopa.  
The prize was a SONY Cyber-Shot W620 digital camera.  The team which 
made the presentation this night consisted of Robert Perrish’ Kristofor 
Vaselopulos and Michael Blanton in the back row and Christine Wheaton 
and Whitney Perkins in the front row.  At right in the front row is prize 
winner Alice Canopa and CKCS member Joe Pilla.  The Pilla family is 
hosting Alice Canopa for a couple of months as she practices her 
English.  Alice is a native of Italy and the Pillas have been family friends 
for about 25 years. 
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(Continued from page 1) 

 
The Best Buy team in October consisted of Christine Wheaton, Robert Parrish, Whitney Perkins, 
Michael Blanton and Kristofor Vasalopulos.  Chris Coni was the Apple representative.  During the 
session, Perkins demonstrated wireless memory cards, which allow you to upload pictures to your 
computer or email using Wi-Fi without being at your computer.  Zoni demonstrated the Apple TV, 
Time Capsule and how they can wirelessly integrate all the devices in your home.  Blanton talked 
about the Gaming Department, the pre-orders and digital downloadable content, and the new 
Skylanders: Giants game. 
 

CKCS recorded the second largest attendance at the Resource Center 
for  the Best Buy Tech Night presentation in October 

 
,

 CKCS 
 
 
 
        The Best Buy team attracted a full house during the September Tech Night presentation 
 See story on page 16 
 
 
 
 
 
 
 
 
                                                                                                                                                                            Photo by Boone Baldwin 
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President’s Comments 
 

By Brooke Thomas, CKCS President 
 

TIME CAPSULE – EYE-FI - SKYLANDERS GIANTS – CIRC - 
SONOS - WII U  
 
Do these words mean anything to you?  If not, the answers are at the end of 
this article.  The members who came to last month's Tech Night learned about 
these new technologies and more.  A team of five from Best Buy introduced us 

to these latest gadgets in time for the gift giving season.  Again, we have Christine Wheaton, 
Customer Solutions manager, to thank for bringing the staff who “know their stuff” to demonstrate and 
answer questions.  It was an hour packed full of information.  From the Apple representative to the 
specialists with cameras and video games, they covered what is hot right now.   
 

PROJECT FACELIFT 
 

As a continuing part of Project Facelift, we are working to upgrade CKCS's technology.  During the 
past six months we have realized a need to increase our Internet speed.  We will be exploring our 
options to get 10 Mbps downloading speed.  This need has become apparent with several of our 
classes simultaneously utilizing several computers or tablets with the Internet.   
 
We are also exploring the option of changing to an Internet-base telephone service, also known as 
VoIP (Voice over Internet Protocol).  We will keep you informed as we proceed.  We will port our 
number, so we will be able to keep our current number. 
 

DIRECTOR'S PRIZE 
 

A name was drawn at the October's Tech night for the prize of an extension of a CKCS membership.  
Louis Shain's name was drawn but because he was not present, it was not awarded.  Next month the 
drawing will be for a four month's extension to the winner’s membership.   
 

NEW TECH GADGETS  
 

Tech toys Best Buy shared at October's Tech Night: 
TIMECAPSULE- is a revolutionary backup device that works wirelessly with Time 
Machine in OS X.  
EYE-FI-memory card that enables instant uploads and automatic organization via 
WiFi.   
SKYLANDERS GIANTS-a new video game just released.  
CIRC-photo and video app for sync, organization and storage for up to 20 devises.   
SONOS-wireless home music systems and Hi Fi music players.   
Wii U-The Wii U is an upcoming video game console from Nintendo as the successor to the Wii.   
SMART GLASS- Smart Glass is software that allows you to interact with media on different devices.  

,
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CKCS Coffee Click SIG now meets at new location 

 
 

In October, the Coffee Click SIG moved their weekly meetings to the EXPANSIVE ART store at 125 E 
Reynolds Road in the Crossroads Shopping Center.  Pictured above at the new site are Bruce 
Klobeke, Judith Lesnaw, Larry Neuzel, Joe Dietz, Jim Stephens, Boone Baldwin, Pennie Redmon, 
Brooke Thomas, Fred Kendig, Larry Cox, and James Orborne at right.  Last year the group met at 
Panera Bread and then moved to the CKCS Resource Center.  Expansive Art is a unique store that 
takes photography to a new level.  It has an 8,000 sq. ft. show room and features amazingly BIG 
photos for a new concept in interior design.  A major attraction for the Coffee Click SIG, the store also 
features a coffee house and offers free coffee for the entire group.  The SIG meets each Thursday at 
9 a.m. and offers a casual discussion of mainly photo topics; however; any computer topic is fair 
game and becomes part of group discussion.  The SIG leader is “Larry Cox and Friends”.  There is no 
set format for the gathering.  The public is welcome.   (Photo by Judith Lesnaw) 
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NNoott  aa  mmeemmbbeerr  ??    

WWee  iinnvviittee  yyoouu  ttoo  jjooiinn  CCKKCCSS..  
  

Here is how:  It is simple as 1 – 2 – 3 
 

 (Now a member – be sure to renew.) 
 
 

 

1 
Click on this link http://www.ckcs.org/join/ and fill out the form  (if that doesn’t work, go to 

www.ckcs.org  and click on 

JOIN NOW) - - or 
 

 

2 
Call (859) 373-1000 and a friendly office supervisor will be glad to help you - - or 

 
 

3 
Stop by the CKCS Resource Center at 160 Moore Drive, Lexington 40503   

Office hours Monday through Friday, 10 A.M. to 4 P.M.… 

 
 

  

http://www.ckcs.org/join/
http://www.ckcs.org/
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TECH TALK  
By Joe Isaac 

Windows SIG Leader 
 

Windows 8 
 
 

 

 
 

Microsoft's new Surface TV ad: 
http://www.youtube.com/watch?feature=player_embedded&v=8mSckyoAMHg 
 
Lots of Videos here, just let it run. 
http://cnettv.cnet.com/microsoft-surface-unveiled-first-microsoft-branded-windows-tablet/9742-1_53-
50126519.html    
 

Good, Bad and the Ugly about Windows 8. 
 

First the BAD and a warning! 
 

I downloaded the real Windows 8, October 26, 2012. 
 
My laptop had Vista and I upgraded to Windows 7, but when I downloaded Windows 8 
it wiped out my programs, including Office 2007, Windows Live Mail, Windows Live 
Photo Gallery, etc.  However my photos, email messages and email addresses and 
documents were still there.   

http://www.youtube.com/watch?feature=player_embedded&v=8mSckyoAMHg
http://cnettv.cnet.com/microsoft-surface-unveiled-first-microsoft-branded-windows-tablet/9742-1_53-50126519.html
http://cnettv.cnet.com/microsoft-surface-unveiled-first-microsoft-branded-windows-tablet/9742-1_53-50126519.html
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The UGLY  
 
I had to reinstall Office 2007, Windows Live Mail, Windows Live Photo Gallery, etc.   
 
Uploading from Windows 7 to Windows 8, it is supposed to keep windows settings, 
personal files, and your programs. 

 
The GOOD 
 
1. It boots in about 10 seconds and you don't have to resize your windows; they come 
up full screen. 
 
2. Tile-based Start Screen.  
When you first boot up, the programs you use are in your face, in the Start screen. You 
just click on a tile.  
 
The live tiles are fantastic, they are Live, on the Internet, interactive and always 
updating. They have huge amounts of information on them. I love them. Live tiles 
include Weather, News, Finance, Travel, Sports, etc. 
 
3. If you like Windows 7 stay with it; it is a great operating system.  
 
4. Windows 8 is new and exciting, but the learning curve is tough. 

 

More Windows 8 tips 
 
Click to obtain the details 

 1.Windows 8 tips: Getting started 

 3.Windows 8 tips: productivity 

 4.Windows 8 tips: new options and features 

 5.Windows 8 tips: tweaks and customizations 

 6.Windows 8 tips: Explorer tricks 

 7.Windows 8 tips: troubleshooting 

 

How to prepare your PC for Windows 8 
 
http://howto.cnet.com/8301-11310_39-57479377-285/how-to-prepare-your-pc-for-windows-8/  

 
,
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http://www.techradar.com/news/software/operating-systems/50-windows-8-tips-tricks-and-secrets-1028220/page:1#articleContent
http://www.techradar.com/news/software/operating-systems/50-windows-8-tips-tricks-and-secrets-1028220/page:3#articleContent
http://www.techradar.com/news/software/operating-systems/50-windows-8-tips-tricks-and-secrets-1028220/page:4#articleContent
http://www.techradar.com/news/software/operating-systems/50-windows-8-tips-tricks-and-secrets-1028220/page:5#articleContent
http://www.techradar.com/news/software/operating-systems/50-windows-8-tips-tricks-and-secrets-1028220/page:6#articleContent
http://www.techradar.com/news/software/operating-systems/50-windows-8-tips-tricks-and-secrets-1028220/page:7#articleContent
http://howto.cnet.com/8301-11310_39-57479377-285/how-to-prepare-your-pc-for-windows-8/
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10 November 2012  

 

Bob says come to the  Mystery SIG  
for some ‘tricky mysteries’ 
 
Good attendance and nice feedback mean we must be doing something right.  The next monthly 
installment of the Computer Mystery Workshop will be on Wednesday, November 7th at 1:30 p.m. 
 
We encourage people to bring their own laptop computers and follow the instructions as we go.  We 
slow down once in a while to keep everyone on track.  We have plenty of table space and a strong 
wireless network.  And, we recently upgraded our Internet service from Windstream (3 Mbps) to 
Insightbb (10 Mbps). 
 
For the November meeting we are going to try some tricky mysteries.  
 
First, how to download a program from the Internet and install it on your computer.  If you have not 
done this before there may be some worry but it is not that difficult if you plan ahead.    
 
Second, how to install Apple iTunes on 
your Windows PC and then how to use 
the free RADIO section. Of course, 
iTunes will help you spend a lot of 
money on music, TV shows, movies 
and other items but there are also 
some very enjoyable free features.  
 
Third, if there is time, we will 
demonstrate some Windows desktop 
mysteries such as replacing your 
background photo (or wallpaper), 
modifying your icons, and more tricks 
that make your desktop appearance  
different. 
 
And anytime you are at the CKCS 
Resource Center check the magazine 
rack near the front door – we have 
each of our past mysteries 
documented and available for sale.  
We call them Computer Knowledge 
Cheat Sheets (CKCS) and they are 
priced at 15 cents each to cover the 
cost of paper and printing.  
 
Bring friends, family and questions for some serious technology demystifying.  Visitors are welcome. 

                      ,
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 IF YOU HAVE A LAPTOP, those attending the Mystery 
SIG are encouraged to bring it along.  Often the tips 
recommended may be tried on your laptop as they are 
discussed.  Many without laptops attend as well, but 
laptops get front row seats, simply because those are 
closest to the power supply, if needed.  The Mystery SIG 

is led by Bob Brown, at right. 
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News to use 
 

Directors’ Prize  
 
Each month at the Tech Night, a drawing is conducted from all the names in the CKCS membership 
base.  The prize this month was for a three month extension of the winner’s membership.  The winner 
must be present.  The name drawn on October 8 was Louis Shain.  Mr. Shain was not present at the 
raffle; so next month the drawing will be for a four month extension of the winner’s CKCS 
membership. 
 

Word Processing SIG takes November off 
 
There will be no Word Processing SIG meeting on Tuesday, November 6, 2012.  Larry Trivette 
reminds us that is Election Day and urges all to make your voices heard and V O T E !  His next SIG 
meeting:  Tuesday, December 4, 2012 – two sessions: 1:30 pm & 7:00 pm.  December Topics will 
include:  Viewing Gridlines and  Creating and working with templates 
 

Design a new logo for CKCS 
 
Board member Jan Landers-Lyman is appealing to all CKCS members and friends: use your creative 
abilities to design a logo for CKCS that represents our organization and what we do.  The deadline for 
our Logo contest has been extended until December 1, 2012.  We have many talented individuals in 
our group so this is your chance to show off a bit.  If you have family or friends that are talented 
design artists, call on them to assist in this project.  Please send your entries to Carolyn Nichols at 
carolyn.nichols@insightbb.com.  The winner will receive a free class of his/her choice at CKCS and 
bragging rights.  Put your creative abilities into play and design a new logo for CKCS. We will thank 
you for your help.   
 

New and Renewed Membership report 
 
The typical membership report that appears each month in this newsletter wasn’t ready at this posting 
so next month the report will be for both the months of October and November. 
 
 
 
 
 
 

,
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WORKING WITH WORD 

Use the Snipping Tool to Capture Dropdown Menus 
 
The Snipping Tool screen capture program is included as part of the 
Microsoft Vista and Microsoft Windows 7 operating systems.  I have 
found this tool to be so useful in capturing screen snips for insertion into 
lesson plans and procedural instructions that I have it pinned to my 
taskbar where it is always only a single click away.  However, with a 
dropdown menu open, using the mouse to open the Snipping Tool 
program also closes the open menu.  The solution to this conundrum can 
be found in the Help documentation of the Snipping Tool program (just 
click the Question Mark icon on its program window).  The procedure 
should be applicable to any application program running on the Microsoft 
Vista or Microsoft Windows 7 operating systems. 
 
1. While in an applicable tab of your application program (this example, 

the Internet Explorer 9 browser program), open the Snipping Tool 
program. 
The Snipping Tool window opens ready to capture a snip. 

2. Press the ESC key. 
The Snipping Tool window remains onscreen but is no longer ready to capture a snip. 

3. Open the dropdown menu that you want to capture (this example, the Tools menu) – this may 
require that you click the desired menu twice). 
The first click minimizes the Snipping Tool window to the taskbar while the second click opens the 
menu. 

4. Press the CTRL + PRINT SCREEN keys. 
The Snipping Tool window reappears ready to capture a snip of the open menu. 

5. If necessary, in the Snipping Tool window, click the New snip button arrow and then click 
Rectangular Snip. 

6. Click-hold-and drag a rectangular frame around the open menu. Release the mouse to capture 
the menu snapshot. 

7. Save the snapshot in your desired format and/or copy and paste it into a document. 
 

Sorting Numbered and Bulleted Lists 
 
The Sort tool in Microsoft Word can be used to quickly alphabetize blocks of single line text 
paragraphs according to the first letter in each text line. A problem arises when these single line 
paragraphs include numbered or bulleted lists. Consider this sample document containing information 
for a music CD album collection. Each CD album is represented by a title line consisting of the artists 
name and album name, followed by a numbered track listing of the songs on the CD. 
 

The Band Perry — The Band Perry 
1. You Lie 
2. If I Die Young 
3. Postcard From Paris 

Raul Malo — Lucky One 

 
Larry Trivette 

Word Processing  
SIG Leader 



13 November 2012  

 

1. Lucky One 
2. Moonlight Kiss 
3. Rosalie 

Lady Antebellum — Own the Night 
1. We Owned The Night 
2. Just A Kiss 
3. Cold As Stone 

 
Follow these steps to apply the normal sort procedure on this block of text. 
1. Select (highlight) all of the text lines. 
2. On the Home tab, in the Paragraph group, click the Sort tool icon. 
3. In the Sort Text dialog box, select sort options: Sort by = Paragraphs; Type = Text, Ascending. 
4. Click OK. 
 
The normal sort results are shown below. 
 

1. Cold As Stone 
1. If I Die Young 
2. Just A Kiss 

Lady Antebellum — Own the Night 
1. Lucky One 
2. Moonlight Kiss 
2. Postcard From Paris 

Raul Malo — Lucky One 
3. Rosalie 

The Band Perry — The Band Perry 
3. We Owned The Night 
3. You Lie 

 
The title lines and the song track list lines are now intermingled alphabetically within the sorted text. 
What is needed is a method whereby only the title lines are sorted, yet retain their individual, 
associated song track list lines unsorted. This can be accomplished by first formatting the title lines as 
a Heading 1 style. After switching to Outline View mode, these Heading 1 style lines can be selected 
as the only text to be displayed. The title lines can then be sorted to achieve the desired results. 
These steps are applicable when using Microsoft Word 2007 and Word 2010. Equivalent steps will be 
required when using Word 2003 and earlier versions of Word. The procedure when using bulleted 
lists is the same. 
 
1. With the mouse pointer in the left margin, opposite the first title line, click once to select 

(highlight) the entire line. 
2. On the Home tab, in the Styles group, click the Heading 1 style. You may apply additional font 

and paragraph formatting as desired (this example: Font = Bold, Font Size = 14, Font Color = 
Black, Paragraph Spacing Before = 0 pt.). 

3. On the Home tab, in the Clipboard group, double-click the Format Painter tool. 
4. With the mouse pointer in the left margin, click each remaining title line to apply the copied 

Heading 1 style formatting. 
5. On the View tab, in the Document Views group, click Outline View. 

The Outlining tab opens on the ribbon toolbar. 
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6. In the Outline Tools group, click the Show Level arrow and select Level 1. 
Now only the Heading 1 title lines display. 

7. On the Home tab, in the Paragraph group, click Sort. 
The Heading 1 title lines are highlighted and the Sort Text dialog box opens. 

8. In the Sort Text dialog box, select sort options: Sort by = Paragraphs, Type = Text, Ascending, 
and then click OK. 
The Heading 1 title lines are sorted alphabetically. 

9. On the Outlining tab, in the Close group, click Close Outline View. 
The Heading 1 title lines are arranged alphabetically, but with their associated numbered song 
track listings remaining in their original order. 

 
Lady Antebellum — Own the Night 

1. We Owned The Night 
2. Just A Kiss 
3. Cold As Stone 

Raul Malo — Lucky One 
1. Lucky One 
2. Moonlight Kiss 
3. Rosalie 

The Band Perry — The Band Perry 
1. You Lie 
2. If I Die Young 
3. Postcard From Paris 

 
 

Please join us at one of our next Word Processing SIG sessions on Tuesday, December 4, 
2012, where we will cover more helpful tools, tricks, and shortcuts.   

Guests are welcomed, so bring a friend. 
 

 
,
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Digital Photography Special Interest Group 

 

The Art of Photography – Composition 
 
On November 27, 2012, this SIG will be devoted to” The Art of 
Photography – Composition.” 
 
According to Wikipedia – Composition is the plan, placement or 
arrangement of the elements of art in a work. (Such as a photograph.) 
 
CKCS recently held a seminar on “Composition”.  This consisted of 2 hours 
of discussion about composition and then 2 hours practicing these 
principles at the Arboretum.  Each of the attendees took a lot of pictures, 
some of which we will look at and discuss at this SIG. 
 
Join us as we continue with a discussion of Composition.  We will be 
discussing the guidelines of composition such as leading lines, symmetry, 
framing, cropping and much more.  
 
This is not a discussion of camera settings but how to look at your subject and be able to get the best 
pictures out of it.  Boone Baldwin, Larry Neuzel, and Joe Dietz will head up the discussion but will 
want lots of input from the attendees. 
 
The photo contest this month is “A Tree with Character”.  Check out your photos or go out and get a 
picture of that special tree you have been waiting to photograph.  E-mail it to joedietz@aol.com no 
later than November 26, 2012. 
 

 

The October Contest winner 
 
 
 
 

FOG and MIST 
 
Photographer:  

CAROL NICHOLS 
 
 
 
 

 
CKCS 
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Mac and iPad Corner 

Entirely on an iPad? This Column Is Proof—Almost 
             Composed, written, and edited on Apple's tablet computer 
 

 
By Kurt Jefferson,  

SIG Leader and Instructor for Mac & iPad topics 

 
This is possibly the first ever multi–page column written for CKCS almost 

entirely on a tablet computer. The procedure is a bit different, there's 
a bit of a learning curve, but what you're reading now is proof…  

  
 
I began this column as an experiment. Could I type an entire column for 
the CKCS newsletter on my iPad?  
 
I was quite comfortable using a Mac mini, Logitech trackball, Apple wireless keyboard and trackpad, 
along with Word for Mac (part of Microsoft Office 2011 suite) to get  
the job done. 
 
But, could I really use Apple's extremely popular tablet to compose, edit, insert graphics, and email to 
editor Jerry Heaton, an entire column by deadline and still keep my sanity?   
 
You might be asking yourself, how? Microsoft doesn't make an iOS version of Word (iOS is the 
operating system that runs on Apple's mobile devices, including the iPad).  

 
The iPad's virtual on–screen keyboard is fine for 
email, the Web, light graphics work, video streaming, 
and news reading. But could I get by using that to 
type an entire column? And what about graphics?  
 
On the Mac, it's a drag-and-drop affair.  
 
One has to jump through hoops to insert photos and 
other graphics into a column created on the iPad, 
right? 

 
Here are the answers to those and other questions. First, tech–savvy folks know 
that Apple's word processor and page layout software, called Pages, easily 
saves documents in Word format so that anyone using Word on a Mac or 
Windows computer can open those files.  
 
I thought about using Pages to create this column, but settled upon an app 
called Smart Office 2. (Full disclosure: I did copy some text into Pages on the 
Mac and then paste that text into Smart Office 2 on the iPad. Graphics were inserted on the Mac for 
uniformity so that I could see how they appeared in Word. Since Word for Mac files automatically 
open in Word for Windows, I could get a picture of how the column would look when editor Heaton 
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opened it. In addition, I viewed the final product in Word on the Mac before emailing the column to 
Heaton. So I did do much of the work on the iPad, but also used Word on the Mac). 
 

USA Today says, "Smart Office 2 lets you create a Microsoft 
Office–compatible document from scratch or view and edit an 
existing one brought onto your iPad, iPhone or iPod touch. Along 
with cloud support, you can open up attachments in an email, 
(“Open In”) or drag and drop files when connected to a PC or Mac 
(from within iTunes).” 
 
Do I think Smart Office 2 is perfect? No. Periodically, I had trouble 
getting the cursor (insertion point) to appear in the document 
where I wanted it to, using a stylus.  
 
Arial font, size 12 is the standard for the column text. Smart Office 
2 kept transforming a portion of the text to Times New Roman. 
Also, I was not able to create hyperlinks using Smart Office 2. 
Those blue, underlined words are indispensable in a column such 
as this. You click on a link and it magically takes you to a Web site 
offering more information. I couldn’t get this to work. 

 
The interface is unconventional and doesn't exactly follow what I’m used to from iOS. At times, the 
program seemed to crawl (probably due to memory issues). It’s clear this program is not meant for 
multi–page columns with color graphics and plenty of text. In addition, Picsel, the firm that makes 

Smart Office 2, has faced considerable financial troubles, 
according to several Web sites.  
 
That said, the software did get the job done, even though, at times, 
I longed for the Mac running OS X. In all fairness, OS X is well over 
a decade old and plenty of time has passed for third–party software 
to meet the Mac's rigid standards.   
 
iOS is a mere baby by comparison, and Smart Office 2 is still quite 
young in its development.   
 

More than anything else, this showed me that we are in a period of transition. Many experts claim that 
tablets are the future—they will replace traditional PCs and monitors.  
 
In April of this year, Forrester Research issued a report titled, Tablets Will Rule the Future Personal 
Computing Landscape—We’ll Use Tablets As the Conductor for PCs, Devices, and Personal Cloud 
Services at Work and at Home. To download the report, I would have to pay $2,495. Obviously, I 
didn’t see the report.  
 
I did see a story in the L.A. Times, which sums up that report. “A paradigm shift may be coming to the 
digital lifestyle. Instead of the PC being the center of the personal computing universe,  
 
For more MAC article pages click link here:                Mac Column by Kurt Jefferson  CONTINUED 
 

http://content.usatoday.com/communities/technologylive/post/2012/06/smart-office-2-a-versatile-software-suite/1
http://www.forrester.com/Tablets+Will+Rule+The+Future+Personal+Computing+Landscape/fulltext/-/E-RES71581
http://articles.latimes.com/2012/apr/23/business/la-fi-tn-tablets-forrester-report-20120423
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THIS MONTH’S BEST VIDEOS / SHOWS  
INSTRUCTIONS: The best way to view these shows:  Viewers should highlight, copy and 

paste the links into a new tab of their Internet browser rather than clicking the links directly in the PDF newsletter  This 
will allow the newsletter to remain open while the link opens and plays in another tab window.  When returning to the 

newsletter, the viewer doesn’t have to wait each time until the large PDF newsletter file reloads.   

THANKS TO CKCS BOARD MEMBER LARRY TRIVETTE FOR THIS SUGGESTION 
 

 

 
Baby fawn somehow got stuck under some rocks 

http://www.wimp.com/fawnrescued/      
Furnished by John Heaton 

 
Sophisticated mapping program can find your exact location 

http://www.darnay.com/iec/features/locator/index.html 
 

 
A ventriloquist without a dummy 

http://www.boreme.com/posting.php?viral_id=27735&page=1  
Furnished by John Heaton 

 
Felix Baumgartner's free fall from the edge of space (complete video) 

http://www.wimp.com/spacefall/      
Furnished by Ted Mellinger 

 
Dance of 1000 hands 

 http://www.youtube.com/embed/7vs-H7xLnrs?rel=0     
Furnished by Carl Peter 

 
World’s best bartender? 

http://www.youtube.com/embed/60GJ0dJ1xmE?rel=0 
Furnished by Joe Dietz 
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A FEW FUNNY PAGES 
 
They dressed the 
truck up with the 
guy tied down on 
the roof. 
The driver and 
passengers put on 
Moose heads. 
Then they went 
down the toll road 
Interstate, causing 
16 near accidents. 
Yes, they went to 
jail... Yes, alcohol 
was involved..." 
 
 

Furnished by Carl Peter 

KIDS ANSWER QUESTIONS ABOUT MARRIAGE 
 
HOW DO YOU DECIDE WHO TO MARRY?    
 
1. You got to find somebody who likes the same stuff. Like, if you like sports, she should like it that 
you like sports, and she should keep the chips and dip coming.    
--  Alan, age 10  
 
No person really decides before they grow up who they’re going to marry. God decides it all way 
before, and you get to find out later who you're stuck with.    
--  Kristen, age  10    
 
2.  WHAT IS  THE RIGHT AGE TO GET MARRIED?    
Twenty-three is the best age because you know the person FOREVER by then.   
--   Camille, age 10    
 
3.  HOW CAN A STRANGER TELL IF TWO PEOPLE ARE MARRIED?    
You might have to guess, based on whether they seem to be yelling at the same kids.  
--  Derrick, age  8    
 
4.  WHAT DO YOU THINK YOUR MOM AND DAD HAVE IN  COMMON?    
Both don't want any more kids.     
--  Lori,  age 8    
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5.  WHAT DO MOST PEOPLE DO ON A DATE?    
-Dates are for having fun, and people should use them to get to know each other. Even boys have 
something to say if you listen long enough.    
--  Lynnette, age  8   
   
 
-On the first date, they just tell each other lies and that usually gets them interested enough to go for 
a second date.   
--  Martin, age  10    
   
 
6..  WHEN IS  IT OKAY TO KISS SOMEONE?     
-When they’re rich.    
--  Pam, age  7  
   
 
-The law says you have to be eighteen, so I wouldn't want to mess with that.   
-- Curt, age   7  
   
 
-The  rule goes like this: If you kiss someone, then you  should marry them and have kids with them. 
It's the right thing to do.     
-- Howard,  age 8    
   
 
7.  IS IT BETTER TO BE SINGLE OR MARRIED?    
It's better for girls to be single but not for boys. Boys need someone to clean up after them.   
--  Anita, age 9  
   
 
8.  HOW WOULD THE WORLD BE DIFFERENT IF PEOPLE DIDN’T GET MARRIED?     
There  sure would be a lot of kids to explain, wouldn't there?   
--  Kelvin, age 8    
   
 
And the #1 Favorite is .......    
9.  HOW WOULD YOU MAKE A MARRIAGE WORK?     
Tell  your wife that she looks pretty, even if she looks like a dump truck. 
--  Ricky, age 10   
   
 

 
Furnished by Jim Winkler 
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CKCS Special Interest Groups 
Check us out! 
Each month the Central Kentucky Computer Society offers 13 SIGs which may be attended by 
members and their guests.  Below is a summary of what takes place at each SIG.  Information 
is provided by the SIG leader.  Visitors are cordially invited to become active CKCS members. 
 
 

NOTE;  Always check the “Monthly Schedule” and the “Newsletter” link on the CKCS home page for 
any schedule changes.  www.ckcs.org 

 

 

DATABASE SIG 
Meets monthly on the fourth 

Monday  –  Leader Garland Smith 
 
 
 
 

DIGITAL 
PHOTOGRAPHY 
SIG 

Meets monthly on the fourth 
Tuesday  –  Leader Joe Dietz 

The Digital Photography Special 
Interest Group is a forum to provide 
and share information about digital 
imaging.  The SIG frequently has 
guest speakers to cover a wide range 
of topics that are related to digital 
imaging.  Some of our past topics have 
been on digital archiving (AKA 
Backup), getting the best out of your 
point and shoot camera, effective 
lighting when taking pictures, restoring 
old photos and many others.  The goal 
of this SIG is to help attendees to 
better understand digital imaging, 
learning how to get the best out of their 
cameras and how to improve their 
images with digital imaging software 
such as Corel’s Paint Shop Pro, 
Photoshop CS/Elements, Gimp or 
other program.  Each meeting starts 
off with a photo contest with a variety 
of different categories. 
 
 
 
 
 
 
 
 
 
 

DR.  FIXIT SIG 
Meets monthly on the first Saturday 

at 10:00 a.m. –  Leaders: Bob 
Brown, Ben Rice and Mike Seiler.   

CKCS members are eligible to bring in 
sick comuters for evaluation.  Our 
‘experts’  will diagnose the problem 
and if possible make simple repairs.  
All you need to bring is the CPU.  Our 
leaders will use a mouse and monitor 
on hand.  This is a free service for 
members only. 
 
 
 

GENEALOGY SIG 
Meets monthly on the third Tuesday  

–  Leader Phyllis Spiker 

Attendees have an opportunity to ask 
questions, share new ancestors, 
record discoveries or websites.  
Programs are not a course of classes, 
but topics of interest, such as new 
online databases, interpreting 
evidences, genealogy softwares or 
getting acquainted with repositories’ 
websites.  Opportunities for onsite 
research may be suggested.  Wanna 
know, “Who’s your granddaddy?”; or 
“Where’re  the records?” We’ll try to 
help you succeed.  Join us 7 P.M, the 
3rd Tuesday of the month, except 
June, July, and August. 
 
 
 
 
 
 
 
 
 
 
 
 

MAC AND iPAD SIG 
Meets monthly on the second 

Thursday  –  Leader Kurt Jefferson 

The Mac and iPad SIG tackles issues 
to help make both Apple's Mac 
computers and its iPad tablet easier to 
use and more enjoyable. We deal with 
a variety of topics ranging from Mac 
OS X (pronounced "10") to iOS, the 
operating system running Apple's iPad. 
We share tips at every meeting and 
provide insights to empower users to 
get more out of their Macs and their 
iPads. Users are encouraged to bring 
their Mac laptops and iPad tablets to 
experience first hand the tips provided 
at each meeting. Whether you're a 
beginner to the Mac or iPad, of you've 
been using both devices for several 
years, you'll walk away with plenty of 
tips, tricks, and advice to make your 
computing experience more enjoyable.  
 
 
 
 

MICROSOFT 
ACCESS SIG 

Meets monthly on the third 
Thursday –  Leader Stuart Zahalka 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ckcs.org/
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MYSTERY SIG 
Meets monthly on the first Monday 
– Leaders Bob Brown and Wendell 

Curtis 

Meeting topics will be about Internet 
web sites, operating system tips and 
tricks, application software, new 
hardware devices or any other ideas 
from the world of personal computers. 
At each meeting, two or three things 
are presented that you might want to 
do with your computer but may not 
know exactly how.   
 
 
 

WINDOWS SIG 
Meets monthly on the second 
Tuesday  –  Leader Joe Isaac 

The Windows SIG for Windows 7, 8, 
Vista and XP, this SIG or workshop 
meets the 2nd Tuesday of each month 
at 7 p.m...  Topics covered may be: 
Windows 7, Windows Live Mail, 
Internet Explorer, Windows Media 
Player, System Restore, Defrag, 
Desktop, Taskbar, Windows Live 
Photo Gallery, Windows Live Movie 
Maker, Basics, Files and Folders, 
Control Panel, YouTube, Disk 
Cleanup, etc.   
 
To see which topic will be covered 
next go to: 
 http://joescomputertips.blogspot.com/ 

To see a year’s worth of email Tips 
and Reviews go to: 
http://www.ckcs.org/joetips.pdf  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WORD 
PROCESSING SIG 
Meets monthly on the first Tuesday 

– Leader Larry Trivette 

The Word Processing SIG starts with 
questions from classmates where the 
SIG leader and all attending help 
provide solutions and answers.  In fact, 
many of the topics presented during 
each session come from questions 
received by email during the month.  
Topics are presented so that new as 
well as advanced computer users will 
benefit by attending.  This workshop 
uses several Microsoft Word versions 
during the SIG.  
 
 
 

UNIX / LINUX SIG 
Meets monthly on the fourth 

Thursday  –  Leader Lewis Gardner 

The Linux SIG handles a wide range of 
technical topics.  Linux is based on 
Unix which is the granddaddy of 
modern networking.  We spend a 
considerable amount of time on 
servers, networks, routers, access 
points and general network 
configuration.  These operating 
systems are at the heart of many 
devices in our increasingly connected 
world.  Come out and we will try to get 
your questions answered, your 
problems troubleshot or devices 
configured 
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Mac Column by Kurt Jefferson  CONTINUED 
 
 
 
consumers will be opting for tablets as their primary computing device and relying on 
cloud storage to access their content across their devices,” says the article. 
 

Does that mean today’s iPad owners are leading the pack 
into the future? They may very well be.  
 
I have no doubt that today’s toddlers will in the future use an 
iPad (or whatever it’s called by then) to do the work most of 
us do today on Macs and Windows PCs.  
 
A pivotal part of the future is in frames, according to the L.A. 
Times article, which cites the Forrester report. “…Forrester 
predicts that “frames,” a new peripheral with a larger 

display, sensors and processing power, will emerge “for larger–scale applications, small group 
interactions, and presentations.”  
 
“PC will no longer mean personal computers—instead it will be the full spectrum of personal 
computing, from personal cloud services to the broad range of personal technology used for work, 
including tablets, smartphones and frames,” said the story quoting the Forrester report. 
 
What about the companies who market these tablets? The report says, “Apple will hold its 
prominence in the market, even as its market share erodes to tighter competition. Google’s Android, 
however, is expected to suffer due to a fragmented ecosystem, since Android–based tablets aren’t all 
granted equal access to its apps, and be surpassed by rebranded Androids such as Amazon’s 
Kindle.” 
 
In addition, Microsoft is expected to be a major player in the tablet market says the report.  
 

A bushel of Apple numbers to digest 

Like numbers? Apple’s CEO released a slew of them at a late October news conference where 
Apple’s management announced a slew of new iPad and Mac products: 
 

 iOS 6 has been downloaded to more than 200–million devices 

 Two–and–a–half years after it was introduced, Apple sold its 100–millionth iPad 

 Macs are now the #1 desktop and laptop computers in the U.S. 

 Macs have now outsold Windows PCs for six straight years 

 Users of Apple’s Messages software (for texting on the Mac, iPad, iPhone, and iPod touch) are 
now sending 28,000 messages every second 

 More than 5–million iPhone 5 devices have been sold 

 The App Store has more than 700,000 apps—275,000 produced specifically for iPad 
 
Read more from Macworld:  http://tinyurl.com/8e4a4dw  
 

http://tinyurl.com/8e4a4dw
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PCMag.com: iPad mini steals the show,  
but new Macs will please customers, too 
PCMag.com ran the headline above on its web site, summing up Apple’s new product 
announcements in late October. This is one of the best headlines I’ve seen, since the 
spotlight shined brightly on the new iPad mini, yet also lit up new Macs:  
 
  13–inch MacBook Pro with Retina Display  
  iMacs that are 80 percent thinner than prior generation and Fusion drive build–to–order option  
  Mac minis with faster processors, larger hard drives and Fusion drive build–to–order option 

 
In addition, Apple announced a fourth–generation iPad with Retina display, sporting a faster 
processor than the third generation device and using the new Apple Lightning connector.  
 

 Macworld created a slideshow providing photos of Apple’s new product announcements 

 TÚAW provides a guide to help you pick the iPad that best suits you 

 Testing reveals the refreshed Mac minis sporting new Ivy Bridge Intel processors are 
substantially faster than the previous models 

 Learn more about Apple’s new line of iMacs 
 
See individual stories below showing individual specs for Apple’s new iPad and Mac offerings.  
Apple announces the long–rumored iPad 

http://forwardthinking.pcmag.com/none/304311-ipad-mini-steals-the-show-but-new-macs-will-please-consumers-too
http://www.macworld.com/article/2012905/apple-debuts-ipad-mini-among-assorted-mac-hardware-and-software.html
http://www.tuaw.com/2012/10/24/shopping-for-your-ipad-picking-the-pad-that-best-suits-you/
http://www.tuaw.com/2012/10/25/new-mac-mini-tear-down-and-benchmarks-from-mac-mini-vault/
http://www.tuaw.com/2012/10/23/apple-introduces-new-line-of-imacs/
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mini  
For weeks, tech Web sites have been reporting about a new iPad with a 
smaller screen and a smaller price to be released in late October.  
 

It's now reality—and it's called the iPad mini. Apple's Phill Schiller told reporters that it's all–new, 
designed from the ground up.  
 
It's an all–new design that's much thinner and lighter than the regular iPad, and can be held in one 
hand. The new iPad mini starts at a 16 GB version with WiFi only for $329.  
 
For the geeks among us, it has a dual–core A5 chip, twice–as–fast WiFi as the older iPad models, 
FaceTime and iSight cameras, a ten–hour battery life, and a new Lightning connector. The WiFi–only 
model will ship on November 2nd while models capable of connecting to the Internet via a cell signal 
will ship on November 9th.  
 
Apple’s web site outlines the iPad mini’s dimensions:      
Height:  7.87 inches 
Width: 5.3   inches 
Depth:  0.28 inch 
Weight: 0.69 pounds   
 

Fourth generation iPad now reality 
Apple's engineers, designers, promoters, and managers must be working overtime. Just six months 
after the company introduced its “new iPad,” the company introduces a fourth generation iPad.  
 
What's the difference between this newest model and the third generation iPad?  
 
Apple told reporters at its late October news conference 
that an A6X chip powers the newest iPad—meaning faster 
performance—and double the central processing unit 
(CPU) performance of the third generation model. The CPU 
is the brains of the iPad, doing all of the heavy lifting computations.  
 
The new iPad costs the same as the third generation model, comes with a Lightning connector, and 
continues the Retina display screen of its predecessor. 
 

Apple announces new 13–inch MacBook Pro with Retina 
display 
The extremely high–resolution screen known as Retina display now comes to the 13–inch MacBook 
Pro. The new laptop offers a giant four–times increase in resolution over the 13–inch MacBook Pro 
that Apple introduced in early summer.  
 
The new MacBook Pro model now has a resolution of 2560 x 1600 pixels. The new models sport a 
2.5GHz dual–core Intel Core i5 processor.  
 

http://www.apple.com/ipad-mini/overview/
http://www.apple.com/ipad-mini/specs/
http://www.apple.com/ipad/overview/
http://store.apple.com/us/browse/home/shop_mac/family/macbook_pro
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Apple says the new laptop contains two Thunderbolt ports and two USB 3.0 connections, but loses 
the Ethernet and FireWire 800 ports found on the non–Retina display MacBook Pro 13–inch laptop.  
 
The 13–inch model joins the 15–inch model that Apple announced during the summer. Apple's CEO, 
Tim Cook, says Apple makes the biggest selling laptop in America. The newest laptop with Retina 
display might just cement those strong sales. 
 

Apple introduces new iMac; 80% thinner 
model 

The most popular all–in–one desktop computer in the U.S. now has gone 
on a diet.  
 
The iMac has a much thinner form—80 percent thinner than the previous 
generation—and the insides have been upgraded to Intel's Ivy Bridge 
processors.  
 
In addition, all of the new iMac models get USB 3.0. The newest iMacs 
weigh eight pounds less than their predecessors and contain a brand 

new display material, which Apple says provides a clearer screen and better viewing surface. Mac 
mini fans may remember that Apple stopped putting optical drives (the slots where you insert CDs 
and/or DVDs to play discs or burn them) in those models last year. Now the newest iMacs lose optical 
drives. For those that really need them, an optional optical drive is available. 
 

Apple refreshes its Mac Mini 
line 
Just a year after it was last updated, 
Apple's smallest desktop model, the 
Mac mini is now refreshed. The mini 
is quite popular with folks looking for 
the lowest priced Mac, in addition to 
those who enjoy watching streaming 
Internet TV shows and movies.  
 
There are three variations of the new 
Mac mini. Two contain the standard 
version of OS X Mountain Lion, while 
a third model comes with OS X 
server software.  
 
The two standard models offer: 
 

 2.5GHz dual–core Intel Ivy 
Bridge i5 processor with 4GB 

http://store.apple.com/us/browse/home/shop_mac/family/imac
http://store.apple.com/us/browse/home/shop_mac/family/mac_mini
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of RAM and a 500 GB hard drive 
 
OR 
 

 2.3GHz quad–core Ivy Bridge i7 with 4 GB of RAM and a 1 TB hard drive 
 
Both of these models can be customized with faster processors, more RAM, and bigger hard drives.  
 
The third mini contains OS X server and has a quad–core 2.3GHz Ivy Bridge i7 with 4GB of RAM and 
dual 1TB hard drives, which can be built to order.  
 
All of the new Mac minis now have high–speed USB 3.0 in addition to Thunderbolt ports. Prices are 
the same as the earlier generation models.  
 
The base Mac mini starts at $599, while the model with the faster processor and bigger hard drive 
starts at $799. The server model starts at $999.  
 

Fusion Drive is coming to a Mac near 
you 
Just what is this technology called Fusion Drive?  
 
Apple introduced its new Fusion Drive technology in late October, but it may have been 
overshadowed by announcements at the same press event of new iPads and Macs. Put simply, 
Fusion Drive is available as an option on both the iMac and Mac minis.  
 
It is a hybrid that provides both a 128GB Flash drive with a traditional hard drive—all in one. Apple 
senior VP of worldwide marketing, Phil Schiller, told reporters at the press conference that OS X 
Mountain Lion and apps that come built–in with the Mac are on the Flash drive. The files, documents, 
and data you add to your Mac go on the traditional hard drive.  

 
OS X is smart—it determines which programs you 
use most often and moves those files to the Flash 
side of the hard drive.  
 

 Read more about Fusion Drive from Macworld: 
http://tinyurl.com/9vafdof 

 TÚAW tells about Apple’s FAQ section about its 
new Fusion Drive 
 

How Tablet Users 
Read Their News 
Eyetracking gear, iPads and exit interviews.  
 

http://en.wikipedia.org/wiki/Fusion_drive
http://tinyurl.com/9vafdof
http://www.tuaw.com/2012/10/25/apple-posts-fusion-drive-faq/
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Those are the tools that Poynter recently used to figure out how iPad users read news on their tablet 
computers.  
 
The study concluded that iPad users belonged to two types that were either:  
 
1. Intimately involved with the iPad screen and kept almost constant contact as they touched the 

screen to get the best view. 
 
OR 
 
2.   They prepared the screen ahead of time–arranging the text–before reading news stories. 
 
Poynter, which operates a journalism school in Florida, might have hit upon a key factor that could 
help folks who serve up the news do it in a better manner. 
 

Poynter recruited two groups of 36 people to help with the study: 

 18–28 year olds   

 45–55 year olds 
 
Poynter says those in the younger group are “among the first adults who 
don’t have strong recollection of life before digital.” 

 
The latter group is said to have “one foot in the print world, and one foot in the “Net” world.”  
 
Each participant viewed 20 news stories served up in three separate ways: 
 

 One way contained the “traditional” view–like an online newspaper.  

 A second view was called “carousel” and provided photos and headlines for every story.  

 A third view was called “flipboard” and provided four photos, highlighting one story from each 
category (news, sports, business and life.) 

 
The same 20 stories were displayed in the three different modes. 
 
The outcome? 50 percent of readers preferred the “carousel” design type, 35 percent preferred the 
“traditional” view, like an online newspaper, and 15 percent preferred the “flipboard” design. 
 
Another take away from the study is that readers showed a very strong preference to hold the tablet 
in the horizontal or landscape position. 70 percent in exit interviews said they preferred that to the 
vertical or portrait position, though they would switch the orientation, depending upon content.  
 
This is a fascinating study for anyone who owns an iPad, for 
news content creators, and for Web site creators. Another 
interesting tidbit involves the time of day when tablet users  
get their news. It all depends on how many times a day  
they seek news.  
 
For those who check their iPads and other tablets once a day during the week for news: 
 

 39% get their news from 5–9 P.M.  
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 18% get their news before 8 A.M. 

 21% get their news between 8 A.M. and noon 

 11% get their news after 9 P.M.  
 
For those who check their iPads and other tablets multiple times a day during the week for news: 
 

 66% get their news from 5–9 P.M.  

 56% get their news before 8 A.M. 

 50% get their news after 9 P.M. 

 43% get their news between 8 A.M.–noon 

 36% get their news from noon–5 P.M.  
 
Read more about the Poynter eyetrack research: http://tinyurl.com/92vpft6 
 

Newsweek Shuttering Its Print Edition at Year’s End 
Newsmagazine to go digital and call itself “Newsweek 
Global”  
When I was a kid, my parents subscribed to a number of magazines, including Life, Look, and 
Newsweek. I loved thumbing through Life and Look to see the big, oversized photos. Newsweek told 
stories as no other magazine could.  
 
I still remember, when I got a bit older, reading articles about the Vietnam War, the race into space, 
and Kent State shootings. Sure, we got immediate access to news stories from TV and radio. But 
Newsweek provided perspective on the big stories of the day.  
 
Those days are long gone. In fact, I haven’t subscribed to Newsweek in decades. I’m apparently not 
alone. A story from Poynter.org, a Web site by the Poynter Institute, connected to a non–profit 
journalism school in Florida, says Newsweek’s print circulation has plummeted by 51 percent  
since 2007.  
 
Those falling circulation numbers mean the print edition of Newsweek cannot continue operating. 
Soon, the print edition will be no more. The magazine will cease publishing a paper product on 
December 31st. It will be replaced by a digital subscription effort called Newsweek Global.  
 
With Newsweek ceasing its print publication, will readers flock to an iPad version of the product? That 
remains to be seen, but it appears that more and more magazines are joining Newsweek in the digital 
transformation of their publications. And more and more of us are turning to our iPads, iPhones, 
Android phones, and other digital devices to consume news. 
 
An October first article in PaidContent.org says, “New research shows that smartphones and tablet–
toting Americans are packing their day with more news than ever before, allaying publisher fears that 
people might quit the news for other digital distractions.”  
 
Pew Research did the study backing up that premise. Pew found that news was the second most 
popular activity on smartphones and tablets, after email, and folks who had both types of devices 
were likely to consume more overall news than before. 
 

http://tinyurl.com/92vpft6
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Poynter: http://tinyurl.com/8bckf6d 
Paid Content: http://tinyurl.com/8gmfo5b 
Journalism.org: http://tinyurl.com/8d9s9rn 

Rowling: MacBook Air Changed My Life  
Harry Potter author J.K. Rowling praised Apple’s laptop during an appearance at London’s Lincoln 
Center in October.  
 

Publisher’s Lunch reports that she spoke about her writing habits and told a crowd, “the MacBook Air 
changed my life.” It lets her write “everywhere, including some very strange places.”  
 

The MacBook Air is the laptop that Steve Jobs pulled out of a manilla folder at Macworld several 
years ago to “oohs and aahs” from the crowd. MacBook Air screens max out at 13.3 inches and the 
laptop is almost as portable as the iPad. The MacBook Air is also the ultra–thin Mac laptop containing 
flash storage, so it boots up almost immediately. 
 

In early years, Apple relied almost 
entirely upon print ads to sell 
products  
Remember the “I’m a Mac, I’m a PC” TV ads that appeared on network 
and cable TV just a few years ago?  
 

Travel back in time a few decades earlier, and instead of TV commercials, 
Apple spent most of its money on print ads in newspapers and 
magazines.  
 

Retronaut provides an “evolution of Apple Ads 1975–2002.” Click on any 
single ad, and you’ll view a larger version. Scrolling down the page is a 

trip down memory lane for anyone old enough to remember. You’ll spot plenty of ads for the Apple  II 
line, new versions of the Mac operating system (Back then, Apple called it a “System”, such as 
System 7), and colorful ads for the new iMac, introduced in 1998.  
 

You’ll see ads that read, “31,000 student hours later, we still love Apple Computer,” “Ford spent the 
better part of 1903 tackling the same details you’ll handle in minutes with an Apple,” and, “We’ll show 
you how to play the media better than Bush, Clinton, and Perot.” 
 

Check out Retronaut’s page and see how many ads you remember. 
Retronaut: http://tinyurl.com/72abag8 
 

Got an iMac? You Might Be Due a New Hard Drive 
If you bought a Mac with a one–terabyte hard drive between October 2009 and July 
2011, you might qualify for a new hard drive. Apple has announced that 1 TB Seagate 
hard drives used in 21.5–inch and 27–inch iMacs might fail.  
 
If you think your iMac might be due a new hard drive, visit the link directly under this article and enter 
your iMac’s serial number. You can easily access the serial number for your iMac by clicking on the 
apple menu (black menu in upper left–hand corner of the screen) and choosing “About This Mac” in 

http://tinyurl.com/8bckf6d
http://tinyurl.com/8gmfo5b
http://tinyurl.com/8d9s9rn
http://tinyurl.com/72abag8
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the drop–down menu. 
Under OS X at the top, you’ll see the word “version” followed by the version of OS X your machine is 
running. Click on the word “version” twice. Version will be replaced with “Serial Number.” That’s the 
series of numbers and letters you type into the blank on the Apple Hard Drive Replacement Program 
Page. Then tap on the blue “Submit” button after entering the information.  
iMac Hard Drive Replacement Program: http://tinyurl.com/3rzgbxe 
 

Setting Up iCloud on Your iPhone 4–Can It Be Done? 
A reader writes MacLife to ask if he can configure iCloud on his iPhone even though he’s still using a 
Mac running Snow Leopard (OS X 10.6). MacLife’s Cory Bohon writes back, “As long as iOS 5 (or 
higher) is installed on your iPhone 4, then you can still use Find My iPhone without setting up iCloud 
on your Mac.”  Read more here: http://tinyurl.com/8tuzaj3 
 

Will My Mac’s Apps Work With Mountain Lion? 
Plenty of folks are just now upgrading to Mountain Lion (since Apple released version 10.8.2 of its 
Mac operating system), and are asking whether or not their apps will run properly under the new cat. 
The easiest solution is to check the Roaring Apps Web site to see if there are problems with any of 
your most used programs. You can search Roaring App’s database by clicking on a letter at the top of 
the page that corresponds to the first letter of the app in question. 
Roaring Apps Web site: http://tinyurl.com/69jo2u7 
 

50 iOS 6 Tips from Great Britain’s C|Net Site 
“The latest version of Apple’s operating system for iPad, iPhone, and the iPod touch is smarter than 
ever, with slicker graphics, better iCloud integration, and easier sharing,” writes Nik Rawlinson of the 
British version of the tech Web site, C|Net. Here, you’ll find plenty of tips and tricks you may not be 
aware of, including “Tap to set an alarm”, “Hide yourself,” and “Email pull to refresh.” 
50 iOS 6 Tips: http://tinyurl.com/cjxp4fq 
 

Macworld shows six of the most rare Macs 
Plenty of us have iMacs, MacBooks or Mac minis that are relatively new. On the other hand, most of 
us would be hard pressed to locate a 1993 Color Classic II Mac or a 1995 PowerBook 550c. Take a 
look at Macworld’s article and see if you remember any of these models. I don’t remember ever 
seeing any of these models in person.  
Macworld’s item: http://tinyurl.com/979urle 
 

Impressions of Apple’s new iPod touch 
While many of us talk a lot about the iPad and iPhone, the iPod touch doesn’t seem to get as much 
coverage. In a nutshell, it’s similar to the iPhone without the phone. And Apple recently unveiled a 
new version of the touch. Gigaom, the tech Web site, put the device through its paces to see how it 
fared. Kevin C. Tofel writes, “The display is stellar. Apple’s new technique of integrating the touch 
sensor with the display brings the content even higher to the screen surface. More than ever before, it 
appears that the icons are simply painted on the screen; they’re that good.” 
Read more about Kevin’s impressions here: http://tinyurl.com/8jlulnr 
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